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1.1  What is Sage Intelligence - Financial Reporting for Sage ERP X3?
Sage Intelligence - Financial Reporting for sage ERP X3 offers a comprehensive and flexible financial reporting solution, helping companies to easily control,  
automate, and analyze their data to make better informed decisions, more quickly, across their business.

1.2  Why would I want to convert my existing reports to the new revamped Report Designer report?
The revamped Report Designer improves your experience in the following areas:
1. Performance - Improvements in performance of financial reporting due to use of powerful In-Memory technology and simplified SQL queries
2. Scalability - Out the box financial report caters for multiple years, multiple sites, multiple budgets, all 9 dimensions, multiple charts of account and multiple  
 ledgers
3. Multi-currency reporting - Integrated multi-currency support that provides access to exchange rates maintained within Sage ERP X3
4. Account Roll Ups - Ability to cater for ranges of accounts, wildcards and exclusions
5. Flexibility - 100% native use of Excel allows you to be in control of how your reports are formatted making the design and maintenance of financial reports/ 
 financial packs much faster and easier.  
6. Ease of Use - A single financial report catering for financial and analytical data reporting allowing this data to be combined into single layouts.
7. Dimensional Reporting - Reporting Trees allow you to replicate your Sage ERP X3 pyramids and easily perform advanced dimensional filtering.
8. Drill down - Simple right click drill down to balances and transactions from within Excel.
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2.1  I am currently using Sage Intelligence, how do I go about installing and updating my current Sage Intelligence software?
It is recommended that you make use of the information detailed in the Sage Intelligence Installation Guide when upgrading your software. You can upgrade to the 
latest version of Sage Intelligence by doing the following:

1. Download Sage Intelligence - Financial Reporting for Sage ERP X3 (version 6.5) from the Sage Intelligence website www.sageintelligence.com/Downloads. 
2. Save the Sage Intelligence - Financial Reporting for Sage ERP X3.exe file to your local machine or network.
3. Ensure that all instances of Microsoft Excel are closed.
4. Ensure all instances of your existing Sage Intelligence software have been closed.

5. Run the Sage Intelligence - Financial Reporting for Sage ERP X3.exe file and follow the installation steps as per the Installation Guide.
6. Open the Report Manager and under the Tools tab, select “to Bulk Import” to retrieve the latest Report Designer report.

2.2  If I already have Sage Intelligence is there a cost involved in upgrading to the latest version?
No, there is no cost to upgrade to the latest version of Sage Intelligence.

NOTE: Your old reports will run out and function as they did before you upgraded the software. Upgrading will not affect your existing report templates.

          NOTE: You do not need to uninstall your existing Sage Intelligence software before installing the later version.
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3.1  Which operating systems is Sage Intelligence compatible with? 
The following operating systems are supported:

• Windows 7 (32 and 64 bit)
• Windows 8 (32 and 64 bit)
• Windows Server 2008 R2
• Windows Server 2012

3.2  Can Sage Intelligence run on Windows operating system 32bit and 64bit? 
Sage Intelligence supports both 32 and 64 bit versions of Windows. Please refer to Question 2 or the Sage Intelligence Release Notes for more information on sup-
ported operating systems.

3.3  Is Sage Intelligence compatible with Microsoft Office 32 bit and 64 bit?
Yes, Sage Intelligence supports both 32 and 64 bit versions of Microsoft Office. Supported versions of Microsoft Office include:
• Microsoft® Excel® 2007
• Microsoft® Excel® 2010 (32 and 64 bit)
• Microsoft® Excel® 2013 (32 and 64 bit)
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4.1  Can Sage Intelligence connect to any database type? 
Sage Intelligence supports all ODBC drivers and is therefore able to connect to both SQL and Oracle databases, allowing you to report beyond your financials. 

Sage Intelligence has a pre-configured connection and pre-defined financial templates for the SQL version of Sage ERP X3 only. You will be able to set up a  
connection to an Oracle database in the Connector should you wish to report on Oracle data. For more information on setting up connections in the  
Connector, please refer to the Sage Intelligence Help File.

4.2  Why do I need to specify both my Sage Intelligence user credentials as well as SQL Server user credentials when  
        accessing Intelligence Reporting?
When security is enabled in the Security Manager you will only have access to the reports which are associated with your Security Manager role. Your credentials 
therefore limit your access to reports. Sage Intelligence requires SQL server user credentials to access the Sage ERP X3 database when retrieving data to run out 
reports into Excel. SQL server user credentials therefore limit access to the data in the Sage ERP X3 SQL database.

4.3  What reports come standard with Sage Intelligence?
Sage Intelligence comes standard with two variations of the demonstration report template catering for different demonstration data sets and one financial re-
port template which caters for all your reporting needs including both financial and analytical data, multiple Charts of Account, Ledgers, Companies, Dimensions, 
Budgets and more. 
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Demonstration Report Designer SX3 1-1
The Demonstration Report Designer report contains sample financial layouts such as Income Statement, Balance Sheet and Cash Flow based on Sage ERP X3 
demonstration data. The revamped Report Designer includes a Task Pane and enhanced Layout Generator to empower users to take control of all design aspects 
of their reporting layouts.

11



Sage Intelligence - Financial Reporting for Sage ERP X3 
Frequently Asked Questions

Financial Report Designer SX3 1-1
The Report Designer report enables users to create financial layouts based on their Sage ERP X3 data using multiple Charts of Account, Companies, Sites, Budget 
Sets and Dimensions. The revamped Report Designer includes a Task Pane and enhanced Layout Generator, both utilizing a powerful in-memory engine, em-
powering users to take control of all design aspects of their reporting layouts. The Layout Generator contains four pre-defined layouts including a Balance Sheet 
YTD, Income Statement Actual vs Prior based on financial data, Income Statement Actual vs Budget based on analytical data and an analytical Income Statement 
for the current period YTD.
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4.4  Can I use Sage Intelligence for reports containing non-financial data?
Yes. Sage Intelligence has a preconfigured connection and financial containers for the SQL version of Sage ERP X3. You can copy, modify and create new  
containers which access non-financial data from any Sage ERP X3 module, for example, allowing you to access sales data to create Sales Dashboards. For more 

information on creating containers in the Connector, please refer to the Sage Intelligence Help File.

4.5  Can I preserve formulas when distributing Sage Intelligence reports?
Yes it is possible to preserve Report Designer and Excel formulas when distributing reports. In order to preserve formulas when distributing reports you can do the 
following:

1. Format the cells containing the formulas you would like to preserve as locked.
2. Turn on protection for the worksheet.
3. Distribute the worksheet.
3. Note that formulas are retained in the distribution.

Please refer to the Sage Intelligence - Financial Reporting for Sage ERP X3 User Guide for more information on how to preserve formulas during report distribution 

and on how to lock and protect Excel worksheets.

13
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5.1   What is the difference between a Report Manager and a Report Viewer license?
A Report Manager license allows you to create, edit and run out Sage Intelligence reports based on existing containers. The Report Viewer module allows you to 
run out existing Sage Intelligence Financial Reports.

5.2   It may be useful to make certain reports visible only when connecting to a specific SQL database. Is this possible?
Yes. There are two methods to ensure that certain reports are visible only when connected to a given SQL database.

Sage Intelligence provides the concept of Scoping, where a report can be scoped or made available only when connected to a specific SQL  
database. A report that is deemed useful across all databases should be Scoped Globally which is the default for each report. Users can manage scope by 
right-clicking the Home icon in the Report Manager and selecting the Manage Object Scope and specifying the scope of each report relevant to the SQL  
database.

Access to reports can also be restricted via the Security Manager. Users can create a role with access to only certain reports and assign users to that role in order 
to restrict user access to Reports within the Report Viewer and Report Manager modules.

5.3   Is there a way to see what Container a Report is using?
Yes. In the Report Manager ensure that report is not locked Double click on the report in order to view the containers used by the selected report.

5.4   Is there a way to run all the reports in a folder?
Yes. In order to run all the reports in a folder, select the relevant folder. then uUnder the Tools tab select the option to Run All Reports. This will run out all reports 
within the report manager folder selected .

5.5   Are Intelligence Reports automatically backed up and where are the reports backed up to?
No, you will need to do a manual back-up of the reports. To do this go to the Report Manager module select the File tab. Select the Backup Metadata option which 
will ensure that the existing reports are backed up to the location specified.  

TIP: To Unlock a locked report you must copy it and paste it into a folder. You will then be able to view the report properties as well as its underlying 
containers.
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5.6    Is there a limit to the number of reports in the Report Manager or folder?
No, there is no limit to the number of reports in the Report Manager or folder.

5.7    Are there any limitations or specifications in naming reports?
No, Reports and Template names can contain alphanumeric as well as special characters. It is recommended to use meaningful names for reports and sub reports.

5.8    What is a Sub-Query Report, and when would you use it?
A sub query report is used to create a union report.  A Union Report is a group of sub query reports running together in a specified order, with the control to deliver 
all the sub reports’ data into one workbook. This is critical as it eliminates the need to manually consolidate information from multiple Excel workbooks into a single 
workbook. Sub query reports are used to present data together in a single workbook that is unrelated, or comes from various data sources. 

Although Union Reports are a series of sub-reports, they are treated as a single entity. The Report Designer report is an example of a Union report.

5.9    Is there a limit to the number of sub-reports that can be used in a union report?
No, there is no limit to the number of sub-reports that can be used, however, the number of sub-reports used will impact on performance of the union report.

5.10  Can you Export multiple reports from within the Report Manager?
No. You  must export each report individually from the Report Manager Module.

5.11  Can you Import Multiple Reports into the Report Manager?
Yes. You can make use of the Bulk Import option available in the Tools tab of the Report Manager module. The Bulk Import Tool imports all reports in the Report 
Update folder on the auto connect connection.

5.12  Can you create custom system variables to use as Filters or Parameters?
Yes. To create filters and parameters based on system variables select the report inside the Report Manager and in the properties screen select the appropriate tab. 
You can then add a filter or parameter based on a defined system variable. 

TIP: To view system variables select System Variables under the Tools tab in the Report Manager. The set of available System Variables defined can be 
extended by adding custom system variables to the Alchemex.ini file under the section [GlobalSysVars]. 
For more information on how to add custom system variables please refer to the Help File.
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An example of two custom System Variables defined in the Alchemex.ini file is shown below. With this example the System Variables @FINYEARSTART@ and  
@FINYEAREND@ will be available to all reports in Intelligence Reporting.

[GlobalSysVars]
Active=@FINYEARSTART@,@FINYEAREND@
@FINYEARSTART@=01 March 2011
@FINYEAREND@=28 February 2012

5.13  If you have not ticked the mandatory option on a Parameter property could you run a report without entering parameters?
Yes. A report will run out successfully with no parameters specified where the parameter is not mandatory.
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6.1  What is different about the revamped Report Designer and In-Memory Technology?
The revamped Report Designer has incorporated a Report Designer Task Pane as a layout design option which empowers users to take control of all design as-
pects of their reporting layouts. The enhanced Layout Generator remains part of the Report Designer as a layout design option for users should you wish to make 
use of its more structured and guided layout automation.

The model behind both the Task Pane and Layout Generator are based on Excel financial functions which communicate with the In-Memory Database (IMDB) and 
processing engine which will guarantee performance by being able to crunch financial numbers very quickly.

The following enhancements are included in the revamped Report Designer :
• Greatly improved performance due to simplified SQL containers and In-Memory Data Caching. 
• A single Financial Report catering for financial and analytical data reporting, and allowing this data to be combined into a single  
 report
• The Report Designer template is more scalable catering for multiple years, multiple sites, multiple budgets, all nine dimensions, multiple charts of account  

             as well as multiple ledgers.
• Greater flexibility using the Task Pane which is a 100% Excel-based design tool allowing you complete control over report design and easily maintainable  

 reports.
• Multi-currency support that provides access to exchange rates maintained within Sage ERP X3
• Dimensional Reporting Trees allow you to replicate your pyramids from Sage ERP X3 and perform advanced and powerful dimensional filtering.
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6.2  Why does the Report Designer need two design options?
In introducing the Task Pane as a design option we are providing solutions to end-users who wish to take more complete control of changing their reports in Excel, 
but find it difficult to do so without help.

What areas or aspects does the enhancement affect?

Area Old Financial Designer Reports New Report Designer Report using Task Pane or  
Layout Generator

Performance One large data request is sent to the database which can  
sometimes be slow depending on GL account volumes.

Returned data is a single, usually large, table.

GL data formulas inside report layouts can sometimes be hard to 
understand and slow to process if many reports are created within 
one Excel Workbook.

Multiple small data requests are sent to the database which are 
efficient and quick.

Returned data is a set of smaller tables which contain no redundant 
data, greatly reducing report size and speed.

GL data formulas inside both Task Pane and Layout generator report 
layouts use simple Excel functions which utilize a fast In-Memory 
Engine to process data requests

Ease of Use GL data formulas are system generated and difficult to modify 
manually

Changes made in Excel after generating a report are not always 
easily reusable in new reports.

GL data formulas are designed for end-user usage and are simple to 
understand and use. The Layout Generator also makes use of these 
formulas allowing users to easily customize their automated layouts.

The reusable report pieces available can easily be copied and pasted 
from one layout to another.

Accessibility to data The current Layout Generator within the Report Designer module is 
a great tool but doesn’t provide me with easy and complete control 
over all aspects of my report.

Users need to invest a lot of time learning how to change the 
backend of reports to do requirements like five year trends and  
multi-budget reporting.

Allows users to dictate control over each individual Excel cell of the 
report ensuring maximum flexibility and control using the Task Pane.

Creating multi-year and multi-budget reports financial will be easy via 
the use of simple report run-time options.
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6.3  Which Report Designer Tool should I use?
Depending on the level of control you would like in the design of your report and your knowledge of Microsoft Excel, the Layout Generator may be used to simplify 
generating reports, otherwise the task pane may be used. Follow the process below to determine the best option for you to design reports.

If you do not have an advanced knowledge of Excel then the Layout Generator provides an intuitive drag-and-drop interface to design reports. If however, you do 
have an advanced knowledge of Excel and are familiar with Excel formulas then the Task Pane provides a complete solution to design your reports using powerful 
Microsoft Excel functionality, giving you complete control.

Which feature you use will be determined by your reporting requirements summarized as below:

Use Layout Generator When… Use the Task Pane When…

Your reports have been built for you and you rarely ever need to change 
them.

The accounts within your ERP system change frequently and your reporting 
requirements change frequently, requiring you to tweak report designs and logic 
often. 

You don’t consider your reporting needs to be advanced or complex. You need to be able to create and control advanced Financial Reports which suit 
your unique business needs.

You are happy for the cosmetic design and layout of your reports to be  
assumed, automated and you won’t make many changes thereafter.

You want to have full control over the design of your reports and want to be able to 
add or remove elements of the design easily after you have created your report.

You only need to report off of a single budget code and don’t need to report 
off more than just current fiscal year and prior year only.

You need to be able to easily do multi-year (three years and more) and  
multi-budget reporting.

You don’t need to include more than five report layouts inside each Excel  
workbook.

You need to include more than five report layout inside each Excel Workbook.
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6.4  Why is performance of the revamped Report Designer better than the old Report Designer?
There are several reasons for the improved performance:

1. The database queries which are executed against the source database have been simplified so the reports run out into Excel much quicker.

2. The Report Designer uses an efficient In-Memory engine which is much faster when calculating financial values.

6.5  I have spent a lot of time building my own templates with the old Layout Generator and have a list of my own reports now, how are they  
related to the revamped Report Designer and can I reuse my prior work?
If you wish to change your existing generated layouts to take advantage of the new features, you will be able to do so by swapping out the formulas which currently 
return financial values with the new drag-and-drop formulas instead. You will therefore be able to reuse the structure, such as rows, and formatting of your existing 

reports.

6.6  How does this Report Designer update apply to Reporting Trees and Distribution?
The revamped Report Designer will be able to support advanced and powerful organizational filtering in your reports based on Sage ERP X3 Dimensions.

Distribution functionality will remain untouched and will distribute reports regardless of how they are designed. Note that when distributing Report Designer reports 
the reports are distributed with values and not report designer formulas. This is to ensure that you will not be required to have the software installed to view the 

report.

 
6.7  I already bought the Connector for quite a lot of money, why do I need to buy the Report Designer module license if all I will be using is  
Excel?
You will be using Excel however you will also be leveraging the power and flexibility of the drag-and-drop lists and formulas in the Task Pane as well as the  
automation of the new In-memory Layout Generator made available via the Revamped Report Designer. These tools interact with the In-Memory Database to  

ensure a fast and flexible reporting experience.

6.8  Can additional Excel calculations and formatting be added to the layout sheet and still use Reporting Trees?
To ensure that the layouts generated from the Layout Generator based on Reporting Trees retain calculations, you should ensure that the calculations have been 
created and added to the layout inside the Layout Generator tool using the Calculator. Formatting that has been applied to the Excel worksheet will not be  
applied to the layout generated with a Reporting Tree.

Using Reporting Trees from the Task Pane will allow users to make use of standard Excel calculation and formatting without having to worry about losing these 
changes when updating the Reporting Tree.
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6.9  Does the Report Designer work with Microsoft® Excel® 2003?
No, it only works with Excel 2007 and above. This is because it uses technologies that are not supported by Excel 2003.

6.10  Which transactions are included in the Sage Intelligence Report Designer report?
The Report Designer retrieves data from the Sage ERP X3 Balance tables known as BALANCE and BALANA. The following types of transactions are included in 
these tables and will reflect in the values displayed on your report:

Journal Entry Category Actual Template Exceptional Active Simulation Inactive Simulation

Status Final Temporary Final Temporary Final Temporary

Included in the Report 
Designer?

Yes Yes No No No No No No

6.11  When new account/s are added or deleted in the Accounting System, how does the Report Designer know? 
There is no automatic alert that new accounts have been added. But if you are generating a layout the new or deleted account changes will always be included 
in your new layout if you make use of account ranges and wildcards when designing your report and creating your layout generator row sets. Please refer to the 

Report Designer User Guide for more information on using account ranges and wildcards when designing your report.

6.12  What does the Toggle Switch Sign button do when you right-select a row field?
Credits in the General Ledger always come through as negative from your accounting system. The switches allow you to manage the sign control. For example 
convert the Sales figures from negative to record as positive in your report.

23
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6.13  Are signs automatically “toggled” in standard out-of-the-box Report Designer layouts?
Yes, signs are automatically toggled by default.

6.14  When would you want to use the Save Excel Template functionality in the Report Designer?
You would use the Save Excel Template if you want to save a specific Excel layout that you have customized. Once you have selected to save the excel template, 
when you run this report the layout you customized will be delivered in Excel. 

6.15  If you use the Report Designer to create a report, can you send it to other people to view?
Yes. They will be able to view layouts that you have generated if you save the workbook with the generated layout as an Excel workbook. However, the other user 
will not be able to generate report layouts if they do not have the Report Designer licensed on their workstation. 

6.16  If you create a report using the Report Designer and send it to a customer, are they able to run the report if they don’t have the Report  
Designer?
Yes, they would need to import the exported report into their system, run the report using the Report Manager and have the result delivered into an Excel  
workbook. 

6.17  Can you export and import Report Designer reports?
Yes, you can export and import Report Designer reports in exactly the same way you would any Sage Intelligence report.

6.18  Can you use the Report Designer to create non-financial reports?
No, the Report Designer report is limited to financial reports. 

Note: Once you have saved the Excel template to a report for a specific company or set of companies this report becomes specific to that company or 
set of companies, and will deliver incorrect results if used against any other companies. The reason for this is that when you create and link your report, 
a set of the General Ledger account numbers are stored on the layout making that report unique to the specific company’s set of accounts.

Note: They would not be able to generate new Report Designer layouts from the Report Designer ribbon in Excel as they are not licensed to do so. Also, 
note that if the exported report had a saved Excel Template with layout(s), the report would be specific to that company and might return incorrect data 
on the new company’s data.
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6.19  Are you able to export layouts that have been created using the Report Designer?
Yes, layouts created with the Report Designer will be exported along with the report as long as you have selected to Save Excel Template in the Report Manager 
before exporting the report. Users are also able to use standard Excel functionality to copy layouts from one Report Designer report to another.

6.20  Can you create graphs from the Designer reports?
Yes, by using standard Excel functionality that links to your layouts you can make use of the latest Excel features to visualize the information on your layouts.

6.21  How is the Report Designer licensed?
The Report Designer module is a separate license bundled with the Report Manager and Connector. In order to use the Report Designer module you will require a 
Report Designer License. A Report Designer license is included in the 30 day Free Trial License.

6.22  How do you install the Report Designer?
The Report Designer is automatically installed with Sage Intelligence and is activated by a valid Report Designer license.

6.23  Do you have to have Sage Intelligence to run the Report Designer or can I purchase a standalone license?
You need to have Sage Intelligence installed in order to have the Report Designer license. The Report Designer Module is licensed per site.

6.24  Can you copy Report Designer reports?
Yes, as you would any Sage Intelligence report. Reports can be copied by selecting the Copy icon under the Home tab in the Report Manager.

6.25  Can you run aggregated reports using the Report Designer?
Yes. Should you wish to aggregate data from two separate SQL databases you could set up a consolidation connection and then copy the Report Designer  
Containers and Report Template over to that connection. Running this report would then render data from both SQL servers into the source sheets of the Excel 

report and thereby allow users to report on aggregated data.
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6.26  In the previous version of Intelligence Reporting I did not have the functionality to pull through multiple budget sets into my reports; I 
needed the Connector to pull in a separate budget set through a Union Report. How would I now handle that with this new Report Designer 
Report?
The new Report Designer caters for multiple budget sets and versions. It retrieves all of the budget information from the General Ledger when running the report. 
Using the budget formulas available in the Task Pane you can filter on the various budget sets and versions that you want to report on as shown in the image  
below.

Information on which budget codes to use is available by dragging in the Budget Codes list from the Task Pane.
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6.27  How does the Variance button work in the Layout Generator calculator?
The Variance button aids in standard accounting calculations by automatically calculating the difference or variance between the selected amounts such as the 

variance between and Actual and Budgeted amount.

Example:         
If you did $100 worth of sales and your budget is $50 then the Variance is $50 and is a positive value. 
If your cost of sales is $100 and your budget is $50 then the Variance is $50 and is calculated as positive, but should in fact be negative as you are $50 over 
budget.

The IS Variance calculation button assists with this. 
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6.28  Is the Report Designer compatible with Excel 2013?
Yes the Report Designer in Sage Intelligence is compatible with Excel 2007 (32 and 64 bit), Excel 2010 (32 and 64 bit) and Excel 2013 (32 and 64 bit). 

6.29  Why does the Report Designer not have a Mapping Tool anymore?
The Report Designer has introduced Row Sets as the Layout Generator alternative to the Mapping Tool. Row sets allow users to create their own rows based on 
account rules using account numbers, account ranges and wildcarding. For more information on how to use Row Sets please refer to the Report Designer User 
Guide. 

When using the Task Pane you can simply create rows on your report using account rules which map directly to the accounts in your General Ledger. This means 

that there is no additional mapping required.

6.30  How do I use my Dimension Pyramids in my Intelligence Reports?
You can use the Reporting Trees to replicate the dimension pyramids that you have set up in Sage ERP X3. Using the Reporting Tree rollup functionality you will be 

able to replicate the pyramid structure containing dimension groups: 
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7.1  Is it mandatory for a user to have a Connector license to be able to use Sage Intelligence?
You do not require a Connector License to use Intelligence Reporting. Report Viewer licenses can run existing reports to get access to real-time information and 
have some basic filter and change parameter editing capabilities, including drill down. Report Manager licenses have the capabilities of Report Viewer, plus the abil-
ity to make changes to existing reports, create new reports, set up parameters, establish new templates, and more. More powerful report-building capabilities are 
available in the Report Designer module. The Connector Module will give you access to unlimited multiple disparate databases and consolidating data from multiple 

companies, an additional Connector Module is available.

7.2  Why would I use the Connector module?
The Connector further simplifies financial managers’ day-to-day operational tasks by providing access to the information they need from multiple sources and  
consolidation of data from multiple companies. The Connector allows for consolidations and connectivity to unlimited ODBC data sources and includes a graphical 
join tool to simplify database queries.

7.3  Is the Connector module a user or site license?
The connector module is a site license.

7.4  Can you add your own Connection Types in the Connector module?
The Connector module allows reports to be created off any ODBC-compliant database for an unlimited number of companies and databases. Users are able to 
add a new connection to any of the ODBC drivers. Sage Intelligence has a preconfigured SQL connection which enables users to use Sage Intelligence to report on 
Sage ERP X3 data.

7.5  How can I use Sage Intelligence if I am using Oracle?
You would need to install Microsoft-SQL Server Express on one of the servers, as the Login screen requires the user to be authenticated against a Microsoft-SQL 
server database. This would only be required to gain access into the Connector Module but would serve no other purpose.

Once logged into the Connector, you would need to create a connection under the Oracle ODBC connection type and then move all existing Financial Report  

Designer containers to this connection and update the syntax in the containers from Microsoft-SQL to Oracle.
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7.6  What is the difference between the Auto Connect and Consolidation Connection?
A consolidation connection allows users to connect to more than one SQL database. Consolidated reports therefore make use of a consolidation connection to 

allow users to report on information from multiple databases. Auto connection is used for connection to a single database. 

7.7  What types of containers are available and is there an advantage to using one type of Container over another in the Connector module? 
Containers can be based on a database table, view, stored procedure, custom SQL query or a custom join based on two or more tables/views in a database. 

Graphical Joins, existing views and SQL Joins are the preferred methods for creating containers and wherever possible these should be used. Stored procedures 
and SQL query containers provide less flexibility for end users creating new or modifying existing reports off these containers. For example: parameterization of 
reports built off SQL Query and Stored Procedure containers can only be achieved using pass through variables which is an advanced feature of Sage Intelligence.

7.8  Why would it be better for you to use a SQL expression instead of Excel formulas?
Excel Formulas should be a last resort if the end result cannot be achieved through SQL expressions as Excel formulas have a negative effect on file size and per-
formance.

7.9  Am I able to lock Containers?
Support for locking of containers and expressions in the Connector have been deprecated. Users are able to lock reports in the Report Manager module.

7.10  Is there a way to back up your containers?
Yes, in the Connector module select the File tab. Select the Backup Metadata option which will ensure that the existing reports and their containers are backed 
up to the location specified. To specify the backup location go to the file Menu in the Connector and select the Change option. You will then be able to specify the 
back-up location.

7.11  Is there a limit to the number of containers in the Connector?
No, there is no limit to the number of containers in the Connector.
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7.12  Are there any limitations or specifications in naming Containers or Expressions?
It is recommended to provide meaningful names for expressions and data fields, as often database fields are presented in a cryptic manner.

7.13  Can you copy SELECT statements from other reporting systems and use the same statements in the Connector?
Yes, you can copy SQL statements when using a SQL Container. However be wary that depending on how the connection has been set up you will need to verify 
that these statements are valid by either Checking/Testing the container or selecting to Sample Data.

7.14  In the Connector can I add additional Expressions to the Report Designer Container? If so would those expressions be automatically 
added to the source sheets in the Report Designer?
Yes, you are able to add additional expressions to a container. After adding expressions to a container in the Connector you will need to add the expression to the 
relevant sub-report in the Report Manager as well before running the Report, which will ensure that the expression will be added to the correct Report Designer 

data sheet. 

Note: The Report Designer will only load the pre-configured fields into memory. Any additional data rendered to the source sheets will not be loaded into 
memory and will therefore not be accessible using the Report Designer Task Pane or Layout Generator. 
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